```cpp
#include <SPI.h>
#include <RFID.h>
#include "pitches.h"
#include <Wire.h>

LiquidCrystal_I2C lcd(0x27, 16, 2);
RFID rfid(10, 9);

byte datarfid[5] = {0x8C, 0xBE, 0x9C, 0xDE, 0x70}; // ID 1
byte datarfid1[5] = {0x7C, 0xBE, 0x9C, 0xDE, 0x80}; // ID 2
byte datarfid2[5] = {0xBC, 0xBD, 0x9C, 0xDE, 0x43}; // ID 3
byte datarfid3[5] = {0x8C, 0xBE, 0x9C, 0xDE, 0x39}; // ID 4
byte datarfid4[5] = {0xB4, 0xBE, 0x9C, 0xDE, 0x14}; // ID 5
byte datarfid5[5] = {0x9C, 0x23, 0x96, 0xDE, 0xF7}; // ID 6
byte datarfid6[5] = {0xCC, 0xBD, 0x9C, 0xDE, 0x33}; // ID 7
byte datarfid7[5] = {0x6C, 0x14, 0x96, 0xDE, 0x30}; // ID 8
byte datarfid8[5] = {0x8C, 0xBE, 0x9C, 0xDE, 0x70}; // ID 9
byte datarfid9[5] = {0x9C, 0x23, 0x96, 0xDE, 0xF7}; // ID 10

byte serNum[5];
byte data[5];

int access_melody[] = {NOTE_G4, 0, NOTE_A4, 0, NOTE_B4, 0, NOTE_A4, 0, NOTE_B4, 0, NOTE_C5, 0};
int access_noteDurations[] = {8, 8, 8, 8, 8, 8, 8, 8, 8, 8, 8, 8};

int fail_melody[] = {NOTE_G2, 0, NOTE_F2, 0, NOTE_D2, 0, NOTE_F2, 0, NOTE_D2, 0, NOTE_F2, 0, NOTE_D2, 0};
int fail_noteDurations[] = {8, 8, 8, 8, 8, 8, 8, 8, 8, 8, 8, 8};

int relay = 14;
int speaker_pin = 15;
const int buttonPin = 7;
int buttonState = 1;

void setup(){
  lcd.init();
  lcd.init();
  SPI.begin();
  rfid.init();
  pinMode(speaker_pin, OUTPUT);
  pinMode(relay, OUTPUT);
  pinMode(buttonPin, INPUT);
}
```
```cpp
void loop()
{
  lcd.setCursor(0, 0);
  lcd.print("Tempelkan Kartu");
  lcd.setCursor(0, 1);
  lcd.print(" Anda ");

  boolean datarfid_card = true;
  boolean datarfid1_card = true;
  boolean datarfid2_card = true;
  boolean datarfid3_card = true;
  boolean datarfid4_card = true;
  boolean datarfid5_card = true;
  boolean datarfid6_card = true;
  boolean datarfid7_card = true;
  boolean datarfid8_card = true;
  boolean datarfid9_card = true;

  buttonState = digitalRead(buttonPin);

  if (buttonState == LOW)
  {
    lcd.setCursor(0, 0);
    lcd.print("     Tombol     ");
    lcd.setCursor(0, 1);
    lcd.print(" Manual Ditekan ");
    delay(1000);
    lcd.setCursor(0, 0);
    lcd.print(" Pintu Terbuka ");
    lcd.setCursor(0, 1);
    lcd.print("                ");
    delay(1000);
    lcd.clear();
    digitalWrite(relay,HIGH);
    lcd.setCursor(0, 0);
    lcd.print("Dalam : 5 detik ");
    delay(1000);
    lcd.setCursor(0, 1);
    lcd.print("Dalam : 4 detik ");
    delay(1000);
    lcd.setCursor(0, 1);
    lcd.print("Dalam : 3 detik ");
    delay(1000);
    lcd.setCursor(0, 1);
    lcd.print("Dalam : 2 detik ");
    delay(1000);
    lcd.setCursor(0, 1);
    lcd.print("Dalam : 1 detik ");
  }
}
```
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 0 detik ");
digitalWrite(relay,LOW);
}

if (rfid.isCard()){    
    if (rfid.readCardSerial()){    
        delay(1000);
        data[0] = rfid.serNum[0];
        data[1] = rfid.serNum[1];
        data[3] = rfid.serNum[3];
        data[4] = rfid.serNum[4];
    }
}

lcd.setCursor(0,0);
lcd.print("ID = ");

if(data[0] < 16){
    lcd.print("0");
}
lcd.print(data[0],HEX);

if(data[1] < 16){
    lcd.print("0");
}
lcd.print(data[1],HEX);

if(data[2] < 16){
    lcd.print("0");
}
lcd.print(data[2],HEX);

if(data[3] < 16){
    lcd.print("0");
}
lcd.print(data[3],HEX);

if(data[4] < 16){
    lcd.print("0");
}
lcd.print(data[4],HEX);
for (int i = 0; i < 5; i++) {
    if (data[i] != datarfid[i]) datarfid_card = false;
    if (data[i] != datarfid1[i]) datarfid1_card = false;
    if (data[i] != datarfid2[i]) datarfid2_card = false;
    if (data[i] != datarfid3[i]) datarfid3_card = false;
    if (data[i] != datarfid4[i]) datarfid4_card = false;
    if (data[i] != datarfid5[i]) datarfid5_card = false;
    if (data[i] != datarfid6[i]) datarfid6_card = false;
    if (data[i] != datarfid7[i]) datarfid7_card = false;
    if (data[i] != datarfid8[i]) datarfid8_card = false;
    if (data[i] != datarfid9[i]) datarfid9_card = false;
}

lcd.setCursor(0, 1);
lcd.print("                    ");
Serial.println();

if (datarfid_card)
{
    for (int i = 0; i < 12; i++)
    {
        int access_noteDuration = 1000 / access_noteDurations[i];
        tone(speaker_pin, access_melody[i], access_noteDuration);
        int access_pauseBetweenNotes = access_noteDuration * 1.30;
        delay(access_pauseBetweenNotes);
        noTone(speaker_pin);
    }
}
else if (datarfid1_card)
{
    for (int i = 0; i < 12; i++)
    {
        int access_noteDuration = 1000 / access_noteDurations[i];
        tone(speaker_pin, access_melody[i], access_noteDuration);
        int access_pauseBetweenNotes = access_noteDuration * 1.30;
        delay(access_pauseBetweenNotes);
        noTone(speaker_pin);
    }
}
else if (datarfid2_card)
{
    for (int i = 0; i < 12; i++)
    {
        int access_noteDuration = 1000 / access_noteDurations[i];
        tone(speaker_pin, access_melody[i], access_noteDuration);
        int access_pauseBetweenNotes = access_noteDuration * 1.30;
        delay(access_pauseBetweenNotes);
        noTone(speaker_pin);
    }
}
else if (datarfid3_card){
    for (int i = 0; i < 12; i++){
        int access_noteDuration = 1000/access_noteDurations[i];
        tone(speaker_pin, access_melody[i], access_noteDuration);
        int access_pauseBetweenNotes = access_noteDuration * 1.30;
        delay(access_pauseBetweenNotes);
        noTone(speaker_pin);
    }
}

else if (datarfid4_card){
    for (int i = 0; i < 12; i++){
        int access_noteDuration = 1000/access_noteDurations[i];
        tone(speaker_pin, access_melody[i], access_noteDuration);
        int access_pauseBetweenNotes = access_noteDuration * 1.30;
        delay(access_pauseBetweenNotes);
        noTone(speaker_pin);
    }
}

else if (datarfid5_card){
    for (int i = 0; i < 12; i++){
        int access_noteDuration = 1000/access_noteDurations[i];
        tone(speaker_pin, access_melody[i], access_noteDuration);
        int access_pauseBetweenNotes = access_noteDuration * 1.30;
        delay(access_pauseBetweenNotes);
        noTone(speaker_pin);
    }
}

else if (datarfid6_card){
    for (int i = 0; i < 12; i++){
        int access_noteDuration = 1000/access_noteDurations[i];
        tone(speaker_pin, access_melody[i], access_noteDuration);
        int access_pauseBetweenNotes = access_noteDuration * 1.30;
        delay(access_pauseBetweenNotes);
        noTone(speaker_pin);
    }
}

else if (datarfid7_card){
    for (int i = 0; i < 12; i++){
        int access_noteDuration = 1000/access_noteDurations[i];
        tone(speaker_pin, access_melody[i], access_noteDuration);
        int access_pauseBetweenNotes = access_noteDuration * 1.30;
        delay(access_pauseBetweenNotes);
        noTone(speaker_pin);
    }
}
else if (datarfid8_card){
    for (int i = 0; i < 12; i++){
        int access_noteDuration = 1000/access_noteDurations[i];
        tone(speaker_pin, access_melody[i],access_noteDuration);
        int access_pauseBetweenNotes = access_noteDuration * 1.30;
        delay(access_pauseBetweenNotes);
        noTone(speaker_pin);
    }
}

else if (datarfid9_card){
    for (int i = 0; i < 12; i++){
        int access_noteDuration = 1000/access_noteDurations[i];
        tone(speaker_pin, access_melody[i],access_noteDuration);
        int access_pauseBetweenNotes = access_noteDuration * 1.30;
        delay(access_pauseBetweenNotes);
        noTone(speaker_pin);
    }
}
else {
    lcd.setCursor(0,1);
    lcd.print(" RFID Ditolak ");
    for (int i = 0; i < 6; i++){
        int fail_noteDuration = 1000/fail_noteDurations[i];
        tone(speaker_pin, fail_melody[i],fail_noteDuration);
        int fail_pauseBetweenNotes = fail_noteDuration * 1.30;
        delay(fail_pauseBetweenNotes);
        noTone(speaker_pin);
    }
    delay(1000);
    lcd.clear();
}

if (datarfid_card){
    lcd.setCursor(0,1);
    lcd.print(" RFID Diterima");
    delay(1000);
    ldc.setCursor(0,1);
    lcd.print(" Pintu Terbuka ");
    delay(1000);
    ldc.clear();
    digitalWrite(relay,HIGH);
    ldc.setCursor(0,0);
    ldc.print("Pintu Terkunci ");
    ldc.setCursor(0,1);
    ldc.print("Dalam : 5 detik ");
    delay(1000);
if (datarfid1_card){
  lcd.setCursor(0,1);
  lcd.print("Dalam : 4 detik ");
delay(1000);
  lcd.setCursor(0,1);
  lcd.print("Dalam : 3 detik ");
delay(1000);
  lcd.setCursor(0,1);
  lcd.print("Dalam : 2 detik ");
delay(1000);
  lcd.setCursor(0,1);
  lcd.print("Dalam : 1 detik ");
delay(1000);
  lcd.setCursor(0,1);
  lcd.print("Dalam : 0 detik ");
delay(1000);
  digitalWrite(relay,LOW);
}

if (datarfid2_card){
  lcd.setCursor(0,0);
  lcd.print(" RFID Diterima");
delay(1000);
  lcd.setCursor(0,0);
  lcd.print(" Pintu Terbuka ");
delay(1000);
  lcd.setCursor(0,0);
  lcd.print(" Pintu Terkunci ");
delay(1000);
  lcd.setCursor(0,0);
  lcd.print("Dalam : 5 detik ");
delay(1000);
  lcd.setCursor(0,0);
  lcd.print("Dalam : 4 detik ");
delay(1000);
  lcd.setCursor(0,0);
  lcd.print("Dalam : 3 detik ");
delay(1000);
  lcd.setCursor(0,0);
  lcd.print("Dalam : 2 detik ");
delay(1000);
  lcd.setCursor(0,0);
  lcd.print("Dalam : 1 detik ");
delay(1000);
  lcd.setCursor(0,0);
  lcd.print("Dalam : 0 detik ");
delay(1000);
  digitalWrite(relay,HIGH);
lcd.setCursor(0, 1);
lcd.print(" RFID Diterima");
delay(1000);
lcd.setCursor(0, 1);
lcd.print(" Pintu Terbuka ");
delay(1000);
lcd.clear();
digitalWrite(relay,HIGH);
lcd.setCursor(0, 0);
lcd.print("Pintu Terkunci");
lcd.setCursor(0, 1);
lcd.print("Dalam : 5 detik");
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 4 detik");
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 3 detik");
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 2 detik");
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 1 detik");
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 0 detik");
digitalWrite(relay,LOW);
}

if (datarfid3_card){
lcd.setCursor(0, 1);
lcd.print(" RFID Diterima");
delay(1000);
lcd.setCursor(0, 1);
lcd.print(" Pintu Terbuka ");
delay(1000);
lcd.setCursor(0, 0);
lcd.print("Pintu Terkunci");
lcd.setCursor(0, 1);
lcd.print("Dalam : 5 detik");
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 4 detik");
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 3 detik");
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 2 detik");
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 1 detik");
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 0 detik");
digitalWrite(relay,HIGH);
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 2 detik ");
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 1 detik ");
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 0 detik ");
digitalWrite(relay, LOW);
}

if (datarfid4_card){
lcd.setCursor(0, 1);
lcd.print(" RFID Diterima");
delay(1000);
lcd.setCursor(0, 1);
lcd.print(" Pintu Terbuka ");
delay(1000);
lcd.clear();
digitalWrite(relay, HIGH);
lcd.setCursor(0, 0);
lcd.print("Pintu Terkunci ");
lcd.setCursor(0, 1);
lcd.print("Dalam : 5 detik ");
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 4 detik ");
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 3 detik ");
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 2 detik ");
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 1 detik ");
delay(1000);
lcd.setCursor(0, 1);
lcd.print("Dalam : 0 detik ");
digitalWrite(relay, LOW);
}

if (datarfid5_card){
lcd.setCursor(0, 1);
lcd.print(" RFID Diterima");
delay(1000);
lcd.setCursor(0, 1);
lcd.print(" Pintu Terbuka ");
delay(1000);
lcd.clear();
digitalWrite(relay,HIGH);
lcd.setCursor(0,0);
lcd.print("Pintu Terkunci ");
lcd.setCursor(0,1);
lcd.print("Dalam : 5 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 4 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 3 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 2 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 1 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 0 detik ");
delay(1000);
if (datarfid6_card){
  lcd.setCursor(0,1);
lcd.print(" RFID Diterima");
delay(1000);
lcd.setCursor(0,1);
lcd.print(" Pintu Terbuka ");
delay(1000);
lcd.clear();
digitalWrite(relay,LOW);
lcd.setCursor(0,0);
lcd.print("Pintu Terkunci ");
lcd.setCursor(0,1);
lcd.print("Dalam : 5 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 4 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 3 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 2 detik ");
delay(1000);
lcd.setCursor(0,1);
```c
if (datarfid7_card){
    lcd.setCursor(0,1);
    lcd.print(" RFID Diterima");
    delay(1000);
    lcd.setCursor(0,1);
    lcd.print(" Pintu Terbuka ");
    delay(1000);
    lcd.clear();
    digitalWrite(relay, HIGH);
    lcd.setCursor(0,0);
    lcd.print("Pintu Terkunci ");
    delay(1000);
    lcd.setCursor(0,1);
    lcd.print("Dalam : 3 detik ");
    delay(1000);
    lcd.setCursor(0,1);
    lcd.print("Dalam : 2 detik ");
    delay(1000);
    lcd.setCursor(0,1);
    lcd.print("Dalam : 1 detik ");
    delay(1000);
    lcd.setCursor(0,1);
    lcd.print("Dalam : 0 detik ");
    digitalWrite(relay, LOW);
}

if (datarfid8_card){
    lcd.setCursor(0,1);
    lcd.print(" RFID Diterima");
    delay(1000);
    lcd.setCursor(0,1);
    lcd.print(" Pintu Terbuka ");
    delay(1000);
    lcd.setCursor(0,0);
    lcd.print("Pintu Terkunci ");}
lcd.setCursor(0,1);
lcd.print("Dalam : 5 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 4 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 3 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 2 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 1 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 0 detik ");
delay(1000);
digitalWrite(relay,LOW);

}   
if (datarfid9_card){
    lcd.setCursor(0,1);
lcd.print(" RFID Diterima");
delay(1000);
lcd.setCursor(0,1);
lcd.print(" Pintu Terbuka ");
delay(1000);
lcd.clear();
digitalWrite(relay,HIGH);
lcd.setCursor(0,0);
lcd.print("Pintu Terkunci.");
lcd.setCursor(0,1);
lcd.print("Dalam : 5 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 4 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 3 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 2 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 1 detik ");
delay(1000);
lcd.setCursor(0,1);
lcd.print("Dalam : 0 detik ");
digitalWrite(relay,LOW);
rfid.halt();
}
The Arduino Uno is a microcontroller board based on the ATmega328 (datasheet). It has 14 digital input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, a 16 MHz crystal oscillator, a USB connection, a power jack, an ICSP header, and a reset button. It contains everything needed to support the microcontroller; simply connect it to a computer with a USB cable or power it with a AC-to-DC adapter or battery to get started. The Uno differs from all preceding boards in that it does not use the FTDI USB-to-serial driver chip. Instead, it features the Atmega8U2 programmed as a USB-to-serial converter.

“Uno” means one in Italian and is named to mark the upcoming release of Arduino 1.0. The Uno and version 1.0 will be the reference versions of Arduino; moving forward. The Uno is the latest in a series of USB Arduino boards, and the reference model for the Arduino platform; for a comparison with previous versions, see the index of Arduino boards.
## Technical Specification

**Summary**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microcontroller</td>
<td>ATmega328</td>
</tr>
<tr>
<td>Operating Voltage</td>
<td>5V</td>
</tr>
<tr>
<td>Input Voltage (recommended)</td>
<td>7-12V</td>
</tr>
<tr>
<td>Input Voltage (limits)</td>
<td>6-20V</td>
</tr>
<tr>
<td>Digital I/O Pins</td>
<td>14 (of which 6 provide PWM output)</td>
</tr>
<tr>
<td>Analog Input Pins</td>
<td>6</td>
</tr>
<tr>
<td>DC Current per I/O Pin</td>
<td>40 mA</td>
</tr>
<tr>
<td>DC Current for 3.3V Pin</td>
<td>50 mA</td>
</tr>
<tr>
<td>Flash Memory</td>
<td>32 KB of which 0.5 KB used by bootloader</td>
</tr>
<tr>
<td>SRAM</td>
<td>2 KB</td>
</tr>
<tr>
<td>EEPROM</td>
<td>1 KB</td>
</tr>
<tr>
<td>Clock Speed</td>
<td>16 MHz</td>
</tr>
</tbody>
</table>

---

![Arduino Uno Board Diagram](image.png)

- **TX/RX Leds**: Transmitter and Receiver Leds
- **Test Led 13**: Internal test LED
- **USB Interface**: USB connector for programming and power
- **External Power Supply**: Power supply connector
- **ATmega328**: Main microcontroller
- **Power Led**: Power indicator LED
- **ICSP Header**: Programming header
- **Reset Button**: Reset button to restart the board
- **I2C**: Inter-Integrated Circuit bus
- **Digital Pins**: pins used for digital signals
- **Analog Pins**: pins used for analog signals

---

EAGLE files: [arduino-duemilanove-uno-design.zip](#)  Schematic: [arduino-uno-schematic.pdf](#)
The Arduino Uno can be powered via the USB connection or with an external power supply. The power source is selected automatically.

External (non-USB) power can come either from an AC-to-DC adapter (wall wart) or battery. The adapter can be connected by plugging a 2.1mm center-positive plug into the board’s power jack. Leads from a battery can be inserted in the Gnd and Vin pin headers of the POWER connector.

The board can operate on an external supply of 6 to 20 volts. If supplied with less than 7V, however, the 5V pin may supply less than five volts and the board may be unstable. If using more than 12V, the voltage regulator may overheat and damage the board. The recommended range is 7 to 12 volts.

The power pins are as follows:

- **VIN.** The input voltage to the Arduino board when it's using an external power source (as opposed to 5 volts from the USB connection or other regulated power source). You can supply voltage through this pin, or, if supplying voltage via the power jack, access it through this pin.
- **5V.** The regulated power supply used to power the microcontroller and other components on the board. This can come either from VIN via an on-board regulator, or be supplied by USB or another regulated 5V supply.
- **3V3.** A 3.3 volt supply generated by the on-board regulator. Maximum current draw is 50 mA.
- **GND.** Ground pins.

---

### Memory

The Atmega328 has 32 KB of flash memory for storing code (of which 0.5 KB is used for the bootloader); It has also 2 KB of SRAM and 1 KB of EEPROM (which can be read and written with the [EEPROM library](https://www.arduino.cc/en/Reference/EEPROM)).

---

### Input and Output

Each of the 14 digital pins on the Uno can be used as an input or output, using `pinMode()`, `digitalWrite()`, and `digitalRead()` functions. They operate at 5 volts. Each pin can provide or receive a maximum of 40 mA and has an internal pull-up resistor (disconnected by default) of 20–50 kΩ. In addition, some pins have specialized functions:

- **Serial: 0 (RX) and 1 (TX).** Used to receive (RX) and transmit (TX) TTL serial data. These pins are connected to the corresponding pins of the ATmega8U2 USB-to-TTL Serial chip.
- **External Interrupts: 2 and 3.** These pins can be configured to trigger an interrupt on a low value, a rising or falling edge, or a change in value. See the `attachInterrupt()` function for details.
- **PWM: 3, 5, 6, 9, 10, and 11.** Provide 8-bit PWM output with the `analogWrite()` function.
- **SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK).** These pins support SPI communication, which, although provided by the underlying hardware, is not currently included in the Arduino language.

- **LED: 13.** There is a built-in LED connected to digital pin 13. When the pin is HIGH value, the LED is on, when the pin is LOW, it's off.
The Uno has 6 analog inputs, each of which provide 10 bits of resolution (i.e. 1024 different values). By default they measure from ground to 5 volts, though is it possible to change the upper end of their range using the AREF pin and the analogReference() function. Additionally, some pins have specialized functionality:

- **I\(^2\)C**: 4 (SDA) and 5 (SCL). Support I\(^2\)C (TWI) communication using the Wire library.

There are a couple of other pins on the board:

- **AREF**: Reference voltage for the analog inputs. Used with analogReference().
- **Reset**: Bring this line LOW to reset the microcontroller. Typically used to add a reset button to shields which block the one on the board.

See also the [mapping between Arduino pins and Atmega328 ports](#).

### Communication

The Arduino Uno has a number of facilities for communicating with a computer, another Arduino, or other microcontrollers. The ATmega328 provides UART TTL (5V) serial communication, which is available on digital pins 0 (RX) and 1 (TX). An ATmega8U2 on the board channels this serial communication over USB and appears as a virtual com port to software on the computer. The 8U2 firmware uses the standard USB COM drivers, and no external driver is needed. However, on Windows, an *.inf file is required..

The Arduino software includes a serial monitor which allows simple textual data to be sent to and from the Arduino board. The RX and TX LEDs on the board will flash when data is being transmitted via the USB-to-

### Programming

The Arduino Uno can be programmed with the Arduino software (download). Select "Arduino Uno w/ ATmega328" from the Tools > Board menu (according to the microcontroller on your board). For details, see the reference and tutorials.

The ATmega328 on the Arduino Uno comes preburned with a bootloader that allows you to upload new code to it without the use of an external hardware programmer. It communicates using the original STK500 protocol (reference, C header files).

You can also bypass the bootloader and program the microcontroller through the ICSP (In-Circuit Serial Programming) header; see these instructions for details.

The ATmega8U2 firmware source code is available. The ATmega8U2 is loaded with a DFU bootloader, which can be activated by connecting the solder jumper on the back of the board (near the map of Italy) and then resetting the 8U2. You can then use Atmel's FLIP software (Windows) or the DFU programmer (Mac OS X and Linux) to load a new firmware. Or you can use the ISP header with an external programmer (overwriting the DFU bootloader).
Automatic (Software) Reset

Rather than requiring a physical press of the reset button before an upload, the Arduino Uno is designed in a way that allows it to be reset by software running on a connected computer. One of the hardware flow control lines (DTR) of the ATMega8U2 is connected to the reset line of the ATMega328 via a 100 nanofarad capacitor. When this line is asserted (taken low), the reset line drops long enough to reset the chip. The Arduino software uses this capability to allow you to upload code by simply pressing the upload button in the Arduino environment. This means that the bootloader can have a shorter timeout, as the lowering of DTR can be well-coordinated with the start of the upload.

This setup has other implications. When the Uno is connected to either a computer running Mac OS X or Linux, it resets each time a connection is made to it from software (via USB). For the following half-second or so, the bootloader is running on the Uno. While it is programmed to ignore malformed data (i.e. anything besides an upload of new code), it will intercept the first few bytes of data sent to the board after a connection is opened. If a sketch running on the board receives one-time configuration or other data when it first starts, make sure that the software with which it communicates waits a second after opening the connection and before sending this data.

The Uno contains a trace that can be cut to disable the auto-reset. The pads on either side of the trace can be soldered together to re-enable it. It’s labeled “RESET-EN”. You may also be able to disable the auto-reset by connecting a 110 ohm resistor from 5V to the reset line; see this forum thread for details.

USB Overcurrent Protection

The Arduino Uno has a re-settable polyfuse that protects your computer’s USB ports from shorts and overcurrent. Although most computers provide their own internal protection, the fuse provides an extra layer of protection. If more than 500 mA is applied to the USB port, the fuse will automatically break the connection until the short or overload is removed.

Physical Characteristics

The maximum length and width of the Uno PCB are 2.7 and 2.1 inches respectively, with the USB connector and power jack extending beyond the former dimension. Three screw holes allow the board to be attached to a surface or case. Note that the distance between digital pins 7 and 8 is 160 mil (0.16”), not an even multiple of the 100 mil spacing of the other pins.
How to use Arduino

Arduino can sense the environment by receiving input from a variety of sensors and can affect its surroundings by controlling lights, motors, and other actuators. The microcontroller on the board is programmed using the Arduino programming language (based on Wiring) and the Arduino development environment (based on Processing). Arduino projects can be stand-alone or they can communicate with software on running on a computer (e.g. Flash, Processing, MaxMSP).

Arduino is a cross-platform program. You’ll have to follow different instructions for your personal OS. Check on the Arduino site for the latest instructions. http://arduino.cc/en/Guide/HomePage

Linux Install Windows Install Mac Install

Once you have downloaded/unzipped the arduino IDE, you can Plug the Arduino to your PC via USB cable.

Now you’re actually ready to “burn” your first program on the arduino board. To select “blink led”, the physical translation of the well known programming “hello world”, select

File>Sketchbook> Arduino-0017>Examples> Digital>Blink

Once you have your sketch you’ll see something very close to the screenshot on the right.

In Tools>Board select

Now you have to go to Tools>SerialPort and select the right serial port, the one arduino is attached to.
1. **Warranties**

1.1 The producer warrants that its products will conform to the Specifications. This warranty lasts for one (1) years from the date of the sale. The producer shall not be liable for any defects that are caused by neglect, misuse or mistreatment by the Customer, including improper installation or testing, or for any products that have been altered or modified in any way by a Customer. Moreover, the producer shall not be liable for any defects that result from Customer’s design, specifications or instructions for such products. Testing and other quality control techniques are used to the extent the producer deems necessary.

1.2 If any products fail to conform to the warranty set forth above, the producer’s sole liability shall be to replace such products. The producer’s liability shall be limited to products that are determined by the producer not to conform to such warranty. If the producer elects to replace such products, the producer shall have a reasonable time to replacements. Replaced products shall be warranted for a new full warranty period.

1.3 **EXCEPT AS SET FORTH ABOVE, PRODUCTS ARE PROVIDED “AS IS” AND “WITH ALL FAULTS.” THE PRODUCER DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING PRODUCTS, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

1.4 Customer agrees that prior to using any systems that include the producer products, Customer will test such systems and the functionality of the products as used in such systems. The producer may provide technical, applications or design advice, quality characterization, reliability data or other services. Customer acknowledges and agrees that providing these services shall not expand or otherwise affect the producer’s warranties, as set forth above, and no additional obligations or liabilities shall arise from the producer providing such services.

1.5 The Arduino™ products are not authorized for use in safety-critical applications where a failure of the product would reasonably be expected to cause severe personal injury or death. Safety-Critical Applications include, without limitation, life support devices and systems, equipment or systems for the operation of nuclear facilities and weapons systems. Arduino™ products are neither designed nor intended for use in military or aerospace applications or environments and for automotive applications or environment. Customer acknowledges and agrees that any such use of Arduino™ products which is solely at the Customer’s risk, and that Customer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

1.6 Customer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements concerning its products and any use of Arduino™ products in Customer’s applications, notwithstanding any applications-related information or support that may be provided by the producer.

2. **Indemnification**

The Customer acknowledges and agrees to defend, indemnify and hold harmless the producer from and against any and all third-party losses, damages, liabilities and expenses it incurs to the extent directly caused by: (i) an actual breach by a Customer of the representation and warranties made under this terms and conditions or (ii) the gross negligence or willful misconduct by the Customer.

3. **Consequential Damages Waiver**

In no event the producer shall be liable to the Customer or any third parties for any special, collateral, indirect, punitive, incidental, consequential or exemplary damages in connection with or arising out of the products provided hereunder, regardless of whether the producer has been advised of the possibility of such damages. This section will survive the termination of the warranty period.

4. **Changes to specifications**

The producer may make changes to specifications and product descriptions at any time, without notice. The Customer must not rely on the absence or characteristics of any features or instructions marked “reserved” or “undefined.” The producer reserves these for future definition and shall have no responsibility whatsoever for conflicts or incompatibilities arising from future changes to them. The product information on the Web Site or Material is subject to change without notice. Do not finalize a design with this information.

---

**Enviromental Policies**

The producer of Arduino™ has joined the Impatto Zero® policy of LifeGate.it. For each Arduino board produced is created / looked after half squared Km of Costa Rica’s forest’s.
TENTANG PENULIS

ARIF PRABOWO


e-mail : arifprabowo56@yahoo.com

Telp/Hp : 082183938055

Pembimbing Utama, Pembimbing Pendamping,

Tri Hendrawan Budianto, S.T., M.T. Rudy Kurniawan, S.T., M.T.

NP. 307196007 NIP. 198009142015041001